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Preface 
 

This Quick Start Guide provides a fast and friendly introduction on STEEL main features 
and functionalities. All the features and functions of the program are presented and 
explained in detail within the complete User’s Guide, along with informative examples. 

STEEL is an advanced workstation for the designer of Steel Construction, offering a 
complete and reliable solution in the Analysis and Design of Steel Structures of any type, 
shape and size.  The program integrates a user friendly CAD Interface, along with a 
reliable calculation environment, based on the existing regulations and standards. The 
basic core of STEEL consists of four, synergistically cooperating among each other, 
components, the Space Frame Analysis & Member Design component, the Connections 
one (for Simple Connections - Truss Connections, Moment Connections – Frame 
Connections), the Drawing of Frame & Connections module and the Dynamic Spectrum 
Analysis component. In addition, STEEL is empowered by four sophisticated Add-Ons 
which provide the program with an unrivaled advantage: a)  PreSTEEL, a smart wizard for 
the quick insertion of the model, based on existing templates of common and typical 
cases, b)  SteelCONNECT, the tool permitting the design of any type of frame 
connections, c) STEEL Section Editor, enabling the creation of any kind of section, and d) 
SteelPLOT, for high quality final drawings, full detailed and properly updated according to 
the calculation results.  

Apparently, this is not easy to describe all STEEL features and capabilities in a few pages 
quick start guide. For this reason, this guide is divided into 2 short parts, Part 1 that 
describes the installation procedure plus the main menu structure, and Part 2 that 
describes an example, step-by-step. This example gives a good idea about the philosophy 
of the program, and shows the user that learning all the options and capabilities is just a 
matter of getting familiar with the package. 
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1. Installation - Launching 
 

 

1.1 Installing STEEL 

 
1. Insert the CD in your computer CD-ROM drive (e.g. D:, E:) or, if you received your 

software via Internet, run the installation application you downloaded. 

2. When the Setup window appears, choose the language for the installation and click OK. 

3. When the Welcome page appears (as shown below), click Next. 

 

 

 

4. Follow the on-screen instructions until the installation is completed. 

5. After installation, the program is located within the programs list. 
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1.2 Program Structure 
 
STEEL comprises of the following parts: 
 
• Members 
• Foundation 
• Truss Nodes 
• Frame Nodes 
• Drawing 
 
MEMBERS 
 
It is the basic part of the program. In the working environment of MEMBERS you can 
describe your structure and calculate it. You can also check the members adequacy. The 
MEMBERS application is autonomous, which means that the presence of another program 
or another part of VK STEEL is not required. If no other parts of VK STEEL are installed 
then structure analysis is confined up to the members check. In other words it is not 
possible to check the nodes, whether it is a truss or a frame structure, or to produce 
drawings. 
 
FOUNDATION 
 
The FOUNDATION sub-program takes over the check and design of the column base as 
well as the foundation members. The structure foundation may be done either in 
individual bases or in a system of footings and connenecting beams. Although it is an 
independent program it is part of MEMBERS. 
 
TRUSS NODES 
 
The Truss Nodes sub-program takes over the check and design of truss structures nodes. 
It also provides the possibility to produce drawings of the structure model. To be able to 
check and design the nodes, the truss must be previously described in MEMBERS. To 
confirm that the Truss Nodes program has been installed, you have to look for the 
Connection Design (Truss) command in the ANALYSIS menu of the program. If the 
command is absent or disabled then the Truss Nodes program is not installed properly. 
 
FRAME NODES  
 
The Frame Nodes takes over the check and design of frame structure nodes. It 
incorporates the possibility to produce its own technical report – without reference to the 
one produced by MEMBERS – and connections detail drawings. To confirm that the Frame 
Nodes program has been installed, you have to look for the Connection Design (Frame) 
command in the ANALYSIS menu of the program. If the command is absent or disabled 
then the Frame Nodes program is not installed properly. 
 
DRAWING 
 
STEEL can produce and export most of the drawings that are required for the completion 
and validation of a project. The following table features the sorts of technical drawings 
that are available, depending on the program’s composition: 
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VK STEEL PART MEMBERS+ DRAWING SORT 
NODE DRAWIMG FRAME NODE 

STRUCTURE 
DRAWING 

Y Y  

TRUSS NODE 
CONNECTION 
DRAWING 

Y Y  

FOUNDATION 
DRAWING 

 Y  

COLUMN (…) 
DRAWING 

 Y  

FRAME NODE 
CONNECTION 
DRAWING 

  Y 

 
Table 1. Drawing creation availability depending on the composition of VK STEEL (e.g. to 
produce the Frame Node Connection you should have MEMBERS and FRAME NODES – the 
other parts of the program are not essential). 
 
 
All drawings processing and printing is done in an autonomous drawing program, which is 
installed in a separate sub-folder, in the basic STEEL program folder. To confirm that the 
DRAWING part is properly installed, look for the ICAD directory in STEEL. This drawing 
platform is based in 4M’s IntelliCAD and has similar functions with AutoCAD. 
 
 
1.3 Basics of the Working Environment 
 
STEEL is based on the object oriented data processing technology. The formation of the 
simulation to be analyzed, the graphic display of the mathematical model, is reduced to 
the insertion of the elements and calculation of their properties. 
 
STEEL elements are the nodes and members. Depending on the element type, the 
program forms the properties directory. 
 
The “node” object, for example, is the meeting point of the center axes of the members, 
so the properties directory that is formed for every such element includes geometric 
features (e.g. coordinates in the global coordinate system, load values that are 
implemented in the node coordinates). 
 
On the contrary, the “member” object represents an entity with physical essence (e.g. a 
steel beam of a defined length) and as it is obvious, in the properties directory physical 
features (e.g. steel quality, weight etc) are included. 
 
The “object-oriented” term is referred to the complete independence of each element and 
the possibility for the user to alter one of its attributes, without the modification of the 
attributes of the neighboring elements or the whole model. 
 
Thanks to this technology, apart from the easy elements input of elements and 
modification of their attributes, it is possible to copy, cut and paste those attributes at 
any time. 
 
Another important convenience is the possibility to undo an action or even a whole series 
of actions that have preceded. As is the case of most programs created for windows, the 
directory of the actions to be undone is refreshed when the file is saved. In other words, 
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when the Save command has been chosen the possibility to undo previous actions is no 
longer available 
 
All work on STEEL is based on user – program interaction. The program, depending on 
the work stage, prepares the appropriate choices frame, in which the user should work by 
choosing the commands and defining the values of the parameters. Those choices commit 
the program in its turn to accordingly prepare for the next stage. 
 
Information exchange between the user and the program is structured in various entities, 
so that the procedure is simplified and the efficiency improvement. 
 
The entities that are used in STEEL are: 
 
NAME Nature – Usefulness 
Title Bar Informational. The name of the program 

and information on the project are included. 

Menu Bar Functional. It includes all the commands of 
the program, organized in menus. 

Tool Bar Functional. It includes almost all the 
commands of the program, organized in 
shortcuts (buttons). 

Status Bar Informational - functional. Useful messages 
about the work stage in the Project Window 
appear there. It also features some 
commands. 

Project Window or Graphic Display 
Window 

Informational – Functional. It features the 
model, in every work stage, as it is formed 
and saved, much information relating to the 
changes that are being done in it, while 
according to the choice, access to the most 
useful commands is provided, through 
accordingly formed pop-up menus. 

Dialog Box Functional. The program carries many 
different dialog boxes, different to each 
other, according to the functions they are 
destined for. It is one of the most essential 
tools of the interactive communication 
between user and program. 

Properties Frame Informational – Functional. On the one hand 
they feature all the properties of the object 
that has been chosen and on the other hand 
they provide the user with the possibility to 
modify them. 

Message Slide Informational. It features some of the 
useful information on the object that has 
been chosen. 

Pop-up menu Informational.  It is the same as all other 
menus, only in this case it is called by right-
clicking on the project window. It includes 
shortcuts and their content It is formed 
according to the object choice 

 
Table 2. Table entities and their interpretation. 
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WORK ENVIRONMENT PRESENTATION 
 

Title Bar 
 
It includes the 
program logo as 
well as information 
on the number of 
the current project 

Toolbars 
 
They may be 
floating or 
permanently 
placed along the 
sides of the main 
window. They 
include all 
shortcuts 
(buttons) of the 
program 
commands 

Menu Bar 
 
All program 
commands are 
grouped I one of the 
menus that comprise 
the menu bar  

 

Window operation keys 
 
They are the typical 
WINDOWS keys for 
maximizing, minimizing and 
exiting the basic window and 
the current project window 

 
 
 

Horizontal and vertical sliding 
bars 
 
Changing their position also 
moves the model through the 
graphic display window. 

Graphic Display 
Window 
The model is 
displayed here and 
it is processed with 
the use of the 
graphic processing 
tools. 

Message Slide 
 
According to the 
object choice, 
information is 
provided e.g. 
about the nod or 
the member, 
their number and 
their coordinates 

Status Bar 
 
Useful information 
about current 
program functions is 
provided 

Properties Frame 
 
In this frame you can search 
and modify the properties of 
the members you have 
chosen. The fields of the 
frame is automatically 
updated if the member choice 
has changed  
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2. Example 
 

 
The main goal of the example that follows is the quick familiarization of the user with the 
working environment of the VK STEEL program. For this reason emphasis has been given 
to the structure definition procedure (model design), while to avoid an information 
overload the validation of the elements calculations is not extensively commented. 
 
In the example what is explained are the procedure of the design of a simple frame 
structure, its calculation, the members efficiency check according to the requirements of 
Eurocode 3 as well as the check and design of on of its nodes. 
 
After the completion of this example you will have 
 

• A quick familiarization with the most important commands and functions of this 
program 

• A concise view of the work flow in the program 
 
• A project example that you can use in the future, as reference 

 
Read the next paragraphs of this introduction.  Their aim is to inform you on the project 
you intend to create, as well as the ways to look for help about operating matters, that 
are being covered in another part of tho user manual, or the on line help system. 
 
Specifically, 
 
• The next paragraph, STRUCTURE OF THE EXAMPLE, presents, graphically, the main 

steps that will be explained in the next chapters. 
 
• The LOOKING FOR HELP paragraph guides you so that you can take advantage as 

much as possible, of the help system, as you are working on the example 
 
• The ABBREVIATION paragraph includes a table with the printing conventions of this 

example. This table is an essential reference help for the understanding of the 
abbreviated words that are used for the sentences. 

 
 
NOTE: Within the INTRODUCTION Chapter of the complete user manual you will find, 
among others, a short presentation of the working environment and the features of the 
program. 
 
 
STRUCTURE OF THE EXAMPLE 
 
The procedure is structured in ten steps, organized in two units. The first unit (steps 1-7) 
include the actions you can do with the main part of the VK STEEL program, MEMBERS. 
This unit corresponds to the largest part of your work in the program, since after the 
completion of step 7, you will have solved the structure and have secured the efficiency of its 
members, according always to the requirements of the selected regulation (in our example we 
have selected, as Members Regulation, Eurocode 3 and as Aseismic Code, NEAK). 
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The second unit, (steps 8-10) is mainly about nodes design, foundation check and use of 
the program’s results (Printings and Drawings). 
 
The program structure is the following: 
 
FIRST UNIT 
 
1. Step 1 Introduction – Creating the project folder 
 
2. Step 2 Preliminary work – Actions that are required before the description 
 
3. Step 3 Defining the project parameters 
 
4. Step 4 Defining the loads and the load combinations 
 
5. Step 5 Structure description. Modifications and corrections 
 
6. Step 6 Diagnostic checks and calculation 
 
7. Step 7 Members check 
 
8. SECOND UNIT 
 
9. Step 8 Foundation Design 
 
10. Step 9 Connection Design 
 
11. Step 10 Results 
 
 
LOOKING FOR HELP 
 
 
This example has been designed in such way that it guides the beginner user, quickly and 
in a concise way in the completion of a project. For that end the references to alternative 
ways to the same function or more detailed explanations have been omitted.  However, if 
you need any clarification you will need to read the printed user manual where the 
relevant subject is explained in more detail. For example, in STEP 3 Defining the project 
parameters only the parameters determination procedure is mentioned, which is needed 
in the project. Details on the rest of the parameter can be found in paragraph MATERIAL 
LIBRARY of chapter THE “PARAMETERS” MENU. 
 
An other fruitful way to look for more details is through the electronic online help system 
that accompanies the program. 
For the same subject (the “materials” and their parameters) look for details following the 
next procedures. 
 
Start up the program 
 
Press the [F1] key, or execute the command Help>Index (in other words select the Index 
command which you will find in the Help menu). The electronic help window of VK STEEL 
will appear. At the left side of the window you can see the tabs Contents and Search. At 
the center the larger window features the texts of each subject as well as the Hyperlinks 
between the pages. 
 
1. FIRST WAY Select with left click the Contents tab. The list with the contents of help 

will appear, in hierarchical order. 
 

a. Select, with left click the subject THE PARAMETERS MENU. 
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b. On the page, at the central window, left lick on the hyperlink “Material Library”. 

In the same way you can read all the units that comprise the Material Library 
subject, by choosing the relevant hyperlink. 

 
 

2. SECOND WAY. Select the Search tab. The word/phrase search engine will appear, 
which is part of the help system. 

 
a. At the field {Type in the keyword to find} type the word {Materials} 
 
b. Select with left click the [List Topics] button. All the page titles that include the 

word Materials will appear. 
 
c. To end up in the same page, as in the first way, select the title Materials and 

press the button [Display Topics]. Experiment with the other titles. 
 
 
ABBREVIATIONS 
 
No Conventions What it is for Comments – explanations 
1 File>New Program 

command 
It means that you must execute the New 
command, which you will find under the File 
menu of VK STEEL 
 

2 {This Project has not 
been saved. Are you 
sure?} 

Message 
Content. 
Text you 
should type 

Usually the execution of a command is followed 
by the appearance of a message 

3 [CLOSE] Sign on a 
button 

Other examples: [OK], [CANCEL] 
 

4 <DIN> Sign on a list 
or a field 

Select one of the contents of a list, after you 
have opened it, by clicking  on the word with the 
left button of the mouse 

5 LC Left Click Abbreviation of the phrase: Click with the left 
button of the mouse 
 

6 RC Right Click Abbreviation of the phrase: Click with the right 
button of the mouse 

7 LDC Left Double 
Click 

Abbreviation of the phrase: Click twice with the 
left button of the mouse 

8 C:\vk\windows\steel Place of the 
steel folder 

It means: The steel folder is in the windows file, 
which is in the VK file of hard drive c 

9 C:\vk\windows\steel\Win
steel.exe 

Place of the 
Winsteel.exe 
file 

It means: The Winsteel.exe file is in the … etc 

10 C:\vk\windows\steel\… Contents of 
the steel 
folder 

It means: All the files and all the folders that are 
in the folder steel, which is … etc 
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FIRST UNIT 
 
STEP 1 – CREATION OF THE PROJECT FOLDER 
 
Working with VK STEEL starts with the creation of a new project and the appropriate 
adjustment of the program environment. 
 
In the first step you will start up the program and create a New Project. Every new project 
creates a directory in C:\vk\windows\steel\meletes\… as well as a first series of essential files. 
The place where the program looks for the saved projects is determined and therefore you 
should not change it, until you have fully completed your work. If you move, for any reason, 
the project folder to another part of the disk, this project will not be available anymore, on the 
“PROJECT” dialog frame. 
 
• Follow the procedure 
 
Flow User Actions 

 
Start the STEEL 2001 application doing one of the following, 
 
1. Select the WinSTEEL command from the typical Windows 

START>PROGRAMS> WinSTEEL menu. 
 

Program Start Up 

2. LDC the icon that you will find on Windows desktop. (If this 
icon does not exist, read the notice bellow about the ways to 

make an , on the Windows desktop) 
 
 
 
 
 
 
 

3. Select the command FILE>NEW or LC the . The 
dialog frame {NEW PROJECT} will appear 

 
4. With LC select the {Steel} tab and make sure that there is 

no other project with the same number you are about to use. 
 
5. Select again the {New} tab and LC the {Project} icon. Press 

[OK] 
 
6. On the {Steel New Project} dialog frame type the number 

100 on the field {Project}, and the text {Simple frame 
structure} on the “Information” field. 

 
7. Press [OK]. The program has created a directoy named 

{100} where all files of the 100 project will be stored. It has 
also formed appropriately the project window and displays 
the toolbars and the program menu bar. 

 

New Project 

8.  RC on any icon. The TOOL BARS command will appear. Make 
sure that all check boxes will be checked. If any of them is 
not checked, then LC on the check box to select it. 

 
 
 
SHORTCUT CREATION on the Windows desktop. 
 
If a program icon has not been automatically created you can very easily create it by 
following the procedure bellow: 

 
                           

14



 

 
1. RC anywhere on the desktop, as long as there is no other shortcut at this place. 
 
2. On the pop up menu that will appear select the “New” command and LC on the 

command “Shortcut”. The “CREATE SHORTCUT” dialog frame will appear. 
 
3. Press the button [BROWSE]. The familiar dialog frame for files browsing will appear. 

Look for the file Winsteel.exe, in the program folder. If during set up you didn’t 
change the default place of the STEEL folder, then you can look for the file at 
c:\vk\windows\steel\WinSTEEL.exe 

 
4. Press the [NEXT] button. 
 
5. Press the [FINISH] button. 
 
MOVE – COPY – COMPRESS A VK STEEL PROJECT 
 
To move a project of the program from the directory they were saved all you have to do 
is move the folder with the name of the project. The same applies for copying a VK STEEL 
project. The compression of the project is a simple procedure as well, although it requires 
the existence of a relevant application. Many programs or compression algorithms allow 
the compression of files but not of directories. A VK STEEL project, though, does not 
comprise of only one file but of a group of files. This means that for the right compression 
you have to create first the compressed file (e.g. if you use the ZIP algorithm through an 
application, such as WinZip®, the 100.zip file) and you have to include all the files that are 
included in the 100 folder of the VK STEEL project. This can be achieved with the help of 
the command Add to archive of the compression program. 
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STEP 2 PRELIMINARY WORK – REQUIRED TASKS BEFORE THE DESCRIPTION 
 
Before we move on to the structure definition, in the program, we have to mention some 
comments about the tasks that are required to be done first. 
 
INTRODUCTION  
 
The VK STEEL program is designed in such way that it allows any corrections that you 
may need to do during the model definition phase. However the best way to start your 
work is if you have from the start a concise view of your data and you project’s 
requirements. 
 
• More specifically you should 
 
1. Have a clear view of the geometry of the structure and also of the section categories 

that will be used. In other words, you should bear in mind any architectural or other 
constraints and have checked the extent in which the structure you are about to 
define meets them or not. In regard to the sections, the correct choice of category will 
save much of your precious time. 

 
2. Have done some kind of preliminary work in regards to the load. In VK STEEL you can 

input two sorts of load, 
 

 
a. distributed along the member, and 
 
b. concentrated , forced on the nodes. Both the distributed and concentrated on 
the members and nodes respectively, will have to be given in units that are 
according to the regulation that will be used for the design of the members. If, 
for example, Eurocode 3 (EC 3) is being used then the distributed load should be 
given in kN/m and the concentrated in kN. For the time being the program is not 
able to process the loads and therefore the modification of the load from kN/m2, 
as they emerge from the regulations, to kN/m as they have to be input 
distributed on the members, will have to be done by the user. 

 
 

In this unit we will give a description of the problem that we are about to describe and 
solve. Some details will be given about the project data and some drawings and images in 
which you will be able to get as reference any time you have a query during the definition 
of the structure. 
 
NOTE: The regulations that will be used for the structural analysis and design of he 
structure are NEAK and Eurocode therefore to define the loads the relevant provisions of 
Eurocode 1 have been taken into account. 
 
PRELIMINARY MODEL DEFINITION DATA OF THE EXAMPLE 
 
Introduction 

 
The structure we are about to define is a simple space frame that could represent a shed. 
 
Geometry 
 
The structure comprises of two parallel frames that are connected with secondary beams. 
Each frame comprises of two columns of height 4 m and a pair of leaning beams with an 
18.43 degrees angle from the horizontal axis. 
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The frames are connected by parallel secondary beams that, as it is conceded, take part 
in the structural analysis. 
 
To avoid any unwanted relevant distortions, a pair of bracings has been placed in each 
leaning plane, comprising of members, which it is conceded for that they take only 
tension. Those members will be hollow beam of rectangular section and be connected to 
the main beams through brace struts. 
 
The parallel secondary beams system comprises the main mechanism of load transfer 
from the cover (of steel leaves of trapeze section with expectation – in the load – of 
future insulation), of wind pressure and sub-pressure  by snow and moving loads 
(temporary load, as is provided by Eurocode 3 for frames with an angle less than 20 
degrees). 
 
The form of the structure can be seen in the series of successive drawings and images. 

 
 
Image 1. Three dimensional model of the structure after its definition 
 
 
 
 

 
 
Image 2. View of the first frame 
 

 
            

17



 

 
Image 3. Ground Plan (These images have been created with the program VK STEEL 
through the command Export To> Image, combined with the RENDER command 
 
Design Codes 
 
The regulations that have been followed are: 
 
• For loads: Eurocode 1 
 
• Aseismic: NEAK 
 
• For the members: Eurocode 3 
 
When it comes to other assumptions from the aseismic code the followig assumptions 
have been taken: 
 
1. The structure is in Athens 
 
2. The Importance of the building is Σ2 
 
3. The soil is class B 
 
4. The building although a frame, will be designed in elastic area (section class 3) with 

earthquake behavior factor  q = 1.5 
 
5. The foundation coefficient is θ = 1.0 
 
6. ζ = 3.0 % 
 
According to the assumptions above the components of the earthquake coefficient in the 
YX plane are Rd(T)/g x-x = Rd(T)/g = 0.31 while the activity of the vertical component of 
the earthquake is considered negligible. 
 
Loads 
 
For the load of the structure the following assumptions have been made: 
 

• DEAD Dead load strains the secondary beams as distributed load. The main 
beams are being strained due to dead load only on the secondary beams base 
points  
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• WIND & SUB-PRESSURE The wind’s load, for the needs of the example has been 

reduced to only one direction with angle α = 0. In other words the vector of the 
resultant of the load (that corresponds to wind pressure) has the direction of the 
positive Y-axis. Based on this assumption the value and direction of the distributed 
load has been calculated on the columns and secondary beams for the case of 
positive pressure (LC 4: Wind +Y) and sub-pressure (LC 6: Wind –Y). Because the 
frame does not have any draperies (or other surfaces) on a level that is vertical to 
the X-X axis the load of the wind in this direction has not been taken into account 
while, to avoid any complexity, the relevant Eurocode 1 prevision has been 
ignored. 

 
• SNOW For snow load the simplest case of different load has been taken, on the 

left and right leaning surfaces of the frame. Like in the case of wind, the load 
strains the secondary beams as a uniformly distributed along them. Snow load is 
being developed in two Load Cases: LC 8: Snow 1 and LC 9: Snow 2. 

 
• LIVE According to Eurocode 1, even in cases of non-passable roofs, such as the 

case in this example, the live load for the case of repair should be taken into 
account. This load that will also be known as […] is taken based on the weight of 
the workers that will make the maintenance work. 

 
The resulting load due to frame imperfections has been ignored as negligible. 
 
Connections 
 

• COLUMNS The columns are considered to be fixed on flexible footing of cube 
shape, connected with inflexible beams. The support node is considered       to be 
fixed and the assumption that there is a suitable mechanism that transfers the 
torsional moment  to the foundation system. To make more strict the overturning  
check of the footing, the participation percentage of the beams (their inflexibility) 
of torsional moment  receipt has been reduced. In terms of the frames, the nodes 
that connect beams to columns are considered fixed. 

 
• BEAMS The beams have been considered as fixed in terms of their connections to 

the columns as well as each other. 
 

• SECONDARY BEAMS The secondary beams have been considered as pinned in 
both sides. 

 
• ROOF BRACES We have already talked about the crosswise pairs of roof braces. 

We should say here that they will be defined with a buckling length that is twice 
the actual one to make sure that the relevant check will succeed. In practice the 
pair of roof braces is set up ready on the frame and consists of four members 
which are connected in their meeting point with a brace strut. In the program we 
will define those members from the node of one frame to the one on the 
diametrical opposite of the other frame (in other words we will define two 
members of each pair with length twice the actual one). 
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STEP 3 DEFINING THE PROJECT PARAMETERS. 
 
On the 3rd step of the project you will select the aseismic code, the members check code 
and define all their relevant parameters. You will also create the Project Library having 
made the appropriate choices from the General Section Library that accompanies the VK 
STEEL program. The Project Library sections will be used later during members insertion 
(STEP 5). 
 
The whole parameters defining procedure will take place through the “PROJECT 
PARAMETERS” dialog box. 
 
• Follow the procedure 
 

PROGRAM FLOW 
 

USER ACTIONS 

9. Select the command Parameters>Material Library. The 
{PROJECT PARAMETERS} dialog box will appear, which 
includes all the essential code parameters, which are 
organized in successive tabs. 

 
 
10. Pop-up (if it is not already visible) the {CODES}  tab with LC 

on its title. 
 
 
11. On the lists {Design Codes} and {Aseismic Code} select 

<Eurocode (EC3)> and <NEAK> 
 
 
12. Select the <Equivalent Static Analysis Eq 3.7> for the lateral 

seismic forces distribution 
 
 
13. On <LC Factor (Live)> type {0,30} 
 
 
14. On <Termal Loading Value> set to zero {0} 
 
15. Make sure that the check box <Set as Default> is not 

checked. 
 
On the right side of the tab make the following changes: 

 
a. Choose <Zone II> for seismic risk zone. 
 
 
b. Choose <S2> for category of importance. 
 
 
c. Choose <B> for soil class. 
 
 
d. Without clicking any of the {Influence Factor of 

Foundation} options, type <1,5> for the <q> factor 
value. 

 
 

Code Parameters defining 

e. Type <0,15> in the <Tx> and <Ty> fields 
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f. Type <0,15> and <0,6> in the <T1> and <T2> 
fields, respectively 

 
 
g. Type <1,5> and <2,5> in the <Bd(0)>and 

<Bd(T1)> fields, respectively 
 
 
h. Type <0,375> in the <Bdmin> field 
 
 
i. Type <3> in the <Damp.Ratio> field 
 

 

j. When you are finished with all necessary changes 
the <Code> tab should look similar to the one 
illustrated in the following figure. 

 
 
 
NOTE: Defining Rd(T)/Bd(T), Rd(T)/g X-X and Rd(T)/g Y-Y is done automatically so it is 
not necessary to type anything on those fields. 
 
 

 
 
Image 4 The “Design Codes” tab after defining the parameters. 
 
 
 

PROGRAM FLOW 
 

USER ACTIONS 

16. The next step is to select the sections that will be used 
for the structure members you are about to define. With 
LC select the {Section Lirary} tab. The tables that 
comprise your tab provide you with access to the 
General Sections Library, which will enable you to create 
the Project Library, in other words a list of the sections 
that will be used in your project. 

 

Sections Selection- Project 
Library Creation 

 
 
 
 
 
 
 
 
 
 
 

17. Activate – if it is not already active – the check box next 
to <Fe360> and make sure that all other steel qualities 
are not checked. All sections you will select, from now 
on, will be of Fe360 steel quality. 
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18. Select with LC on the left side of the dialog box the IPB 
sections. The table in the middle will show the list of all 
available IPB sections along with their properties 

 
 
19. With LC select the IPB200 section to select it. 

 
 

20. Without moving your cursor away from the selected 
row, with RC pop-up the menu with the commands to 
insert the selected sections to the Project Library. 

 
21. With LC select the Insert Selected Sections command. The 

IPB 200 section has been added to Project Library. 
 
 
 
 

USER ACTIONS 
 
 

22. Repeat process 18 –23 for the following sections, 
 

• IPE 80 
 
• IPE 180 
 
• IPE 220  

 
• KT 40x40x2,6 (Square Hollow Section) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PROGRM FLOW 

23. The Project Library creating process has been completed. 
Notice that the arrow next to all section types that have 
been selected has turned to black. Make sure that <Set as 
Default> (down on the left) is not checked and proceed to 
the next task, in the {PROJECT PARAMETERS} dialog box, 
which is the steel quality parameters check. 

 
 
NOTICE It is understandable that the selection of the Sections is dictated by the nature 
and function of the structure. As it was pointed in Step 2 it is essential that you have 
done some preliminary calculations, so that you avoid multiple tests for the selection of 
the appropriate sections for the structure in question and its load conditions. For this 
example we have selected a IPB200 section for the column which is more suitable for 
combined strain in axial load and biaxial pressure, while for the beams are mainly pressed 
elements (main and secondary) we have chosen IPE80, IPE180 and IPE220 sections. 
Finally, for the roof braces that act only in tension we have chosen square hollow 
sections. 
 
 
 
 
 

PROGRAM FLOW 
 

USER ACTIONS 

24. Chose with LC the {Material Properties} tab. At this point 
the program allows the modification of the steel quality 
parameters 

 
 

Steel Quality Parameters 
Check 

25. Without making any changes move on to the Connections 
parameters 
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26. Select with LC the {CONNECTIONS} tab. At this point the 
program allows the modification of the welds and/or bols 
that will be later used during nodes design. 

 
 

Connections Parameter Check 

27. Without making any changes move on to the Foundation 
parameters 

 
 
28. Select with LC the { Foundation PARAMETERS} tab. At 

this point the program allows access to the foundation 
parameters, which are organized in sub-groups. 

 
29. Select from this list the <[SOIL]> sub-group. With two 

successive LC in every field you can make the necessary 
changes. Make those changes 

 
 

a. On <Moduls of Subgrade Reaction (Ks)> type 
{40000} 

 
b. On <Young Moduls of Soil> type {11000} 

 
 
 
 
 

USER ACTIONS 
 

30. Select from the list the <[MODELING]> sub-group and 
make the following changes: 

 
a. On <Column Perticipation Percentage> type {20} 
 
b. On < Perticipation Percentage in Tie Beam > type 

{60} 
 

c. On <Footing type> type {0}  
 
 

Defining the Foundation 
Parameters 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PROGRAM FLOW 

31. Having completed the defining of the essential 
parameters and after you have made sure that <Set as 
Default> is not checked, press [OK]. Your program will 
save your selections at the parameters file of this project. 
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STEP 4 DEFINING THE LOADS AND LOAD COMBINATIONS 
 
On the forth step you will fill in the load combinations table that will be used for the 
classification of the stress values during the members efficiency test. 
 
Additionally you will separate the given load into member load and nodal load. 
 
Follow the procedure 
 

PROGRAM FLOW USER ACTIONS 
 

32. Select with LC the PARAMETERS>LOAD COMBINATIONS 
command. The Load Combinations table will open. 

 
 
33. On this table, the columns represent the Load Cases while 

the rows represent the load combinations. Each load 
combination, to be valid, should include at least one load 
case. A load case takes part in a load combination if the 
table cell where the combination with load case in 
question meet has a value that is not zero. Those values 
that correspond to the Safety Factors are defined each 
time by the user depending on the project’s special 
requirements. Generally, they are given by the codes. 

 
 
 
 
 
 

USER ACTIONS 
34. We should point here that the factors values are chosen 

for this project only and are not typical. 
 
 

Safety factors selection and 
Load Combination defining 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PROGRAM FLOW 
 
 
 
 
 

35. Type the values of the safety factors, as seen on Table 2 
bellow 

 
 

 
NOTE: We should point that we fill in  the load safety factor according to the regulations 
only in the first three and eleventh columns. In all other cases the title (e.g. Wind + X) is 
just indicative and you could use the column for live loads. 
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 Dead 
Loads 

Seismic
Y 

Seismic 
X 

Wind +Y Wind +X Wind -Y Wind -X 
Snow 
(1) 

Snow 
(2) 

Other 
Loads 

Live 
Loads 

1 
 

1,35                   1,50 

2 
 

1,35     1,50   0,90         0,90 

3 
 

1,35     0,90   1,50         0,90 

4 
 

1,35             1,50 0,90   0,90 

5 
 

1,35             0,90 1,50   0,90 

6 
 

1,35     1,50   0,90   0,90 0,90   0,90 

7 
 

1,35     0,90   1,50   0,90 0,90   0,90 

8 
 

1,00 1,00 0,30               0,30 

9 
 

1,00 0,30 1,00               0,30 

10 
 

1,00 1,00 0,30   1,00   1,00       1,00 

11 
 

1,00 0,30 1,00   1,00   1,00       1,00 

 
Image 5 Load combinations form and the values of the safety factors for the example 
project. 
 
 

PROGRAM FLOW 
 

USER ACTIONS 

36. At this point you should check the loads in relation to the 
load combinations you have just defined. We recommend 
you to compare the table above to all we have 
mentioned about load assumptions at STEP 2 and at the 
“Loads” unit. 

 
 
37. The loads values that will be defined as distributed along 

the member, have resulted from the calculation of the 
weight surface in each member according to its position 
and angle (e.g. Outside – Inside members with an angle 
of the axes of the local coordinates system turned 
towards the load implementation level) 

 
 

 

38. LC on [OK], to close the window. 
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STEP 5 STRUCTURE DEFINING – MODIFICATIONS AND CORRECTIONS. 
 
On the fifth step you will define the elements that comprise the structure and you will 
modify their properties. The data insertion process is the most time consuming stage of 
your work. For this reason the program has many alternative ways for the most 
necessary parts of your work so that the formation of the structure can be simplified. In 
our case we have tried to describe the most possible ways. The more you use the 
program the more you will see that depending on the individual requirements of each 
structure some of the alternative ways for the same work simplify the process more than 
others. In other words, it is not necessary to repeat to the last word this procedure in 
your next project. 
 
• Follow the procedure, 
 

PROGRAM FLOW USER ACTIONS 
 

39. If you do not see the “MEMBERS PROPERTIES” toolbar make 
it visible. The toolbar should look like the on in Image 6 

 
 

 
 
 
 
 
 
 
 
 

40. Select the IPB200(Fe360) section from the <Project 
Library> list 

 
 
41. Select the <Fixed-Fixed> option from the <Constrains> list 
 
42. Type <90> at the EULER field 
 
43. Select <column> in the <Memmers Groups> list 
 
 
USER ACTIONS 
 

44. LC on the  icon. The {Elements Loads} dialog box 
appears. 

  
a. LC the <Wind +Y> option 

 
b. Select the <Local Z> axis as load axis 

 
c. Set the <Q> value to <1,5> 

 
d. Press [Update] and close the dialog box by pressing 
[OK] 

 
 

Columns Insertion 
 
 
 
 
 
 
 
 
 
 
 
 

Image 6 “MEMBERS PROPERTIES” toolbar

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
PROGRAM FLOW 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

45.RC anywhere in the project window. On the pop-up menu 
select WIZARD. You can select the same command from 
the Edit menu. The {New Member} dialog box will 
appear. 
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46. In the <Start Node> dialog box,   fill in the bottom node of 
the column co-ordinates as follows, {1,0}, {1,0}, and 
{1,0}. In the <End Node> dialog box, fill in the top node of 
the column co-ordinates as follows, {1,0}, {1,0} and 
{5,0}. 

     Press the [Add] button and then press [Close]. 
 

 
 
 
 
 
 
 
 
 
 
USER ACTIONS 
 

47. Click on the  icon again.  The {Elements Loads} dialog 
box appears again. Before you do anything else, uncheck 
the <Wind + Y> check box. 

 
a. LC the <Wind -Y> option 
 
b. Select the <Local Z> axis 

 
c. Set the <Q> value to <1,0> 

 
d. Press [Update] and close the dialog box by pressing 

[OK] 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
PROGRAM FLOW 

 
 
 

48. Select the EDIT>WIZARD   command 
 
Like in the previous column, on the values fields type the 
following: SN: {1,0}, {7,0}, {1,0} and EN: {1,0}, {7,0}, 
{5,0}. 
Press the [Add] button and then press [Close]. 

 
Defining Beams 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PROGRAM FLOW 

49. At the {Members Properties} toolbar, make the following 
changes, 

 
a. Select the IPE220(Fe360) section from the <Project 

Library> list. 
 
b. Select the <Fixed-Fixed> option from the 

<Constrains> list. 
 
c. Type <0> at the EULER field 
 
d. Select <beam> in the <Memmbers Groups> list 
 
 
 
 
 

USER ACTIONS 
 

 50. (The beams do not bear any other load apart from the 
secondary beams reaction, so we will not define any 

 
            

27



 

load during their defining) 
Select EDIT>WIZARD, so that the members “New 
Element”dialog  box.  
Uncheck the <Wind - Y> check box. 
 
a. LC to the [Pick] button. Select node 2 (the upper 

node of the left column). 
 
b. RC anywhere in the drawing window. Select the 

SHOW DIALOG command. 
 

c. In the <End Node> fields, type {1,0}, {4,0}, {6,0} 
 

d. LC on <Number of multiple members to insert>. In  
     the field bellow type {3}. 

 
 51. Press the [Add] button and then press [Close]. The 

program has created a beam and divided it to three 
equal parts. 

 
 52. Select EDIT>WIZARD, so that the “New Element” dialog  

box appears. 
 
a. Click on the [Pick] button. Select the nodes indexed 7 

and 4. 
 
b. At the < Number of multiple members to insert > field 

type <3> 
 

 
 
 

 
PROGRAM FLOW USER ACTIONS 

 
 53. Press the [Add] button and then press [Close]. 
 

NOTICE If you cannot see the numbering of members or nodes, select the command 
Parameters>Options>Visible. The dialog box “Visible Items” will appear. Check the options 
Member Names, Node Names. If the nodes themselves are not visible then you can check 
the Nodes option 

 
54. You will now set the start nodes of both columns to 

support joints. Select the command EDIT>SELECT 
NODES 

 
 
55. Press the [Ctrl] key and keep it pressed. Select with LC 

the nodes 1 and 3 (the bottom nodes of the columns). 
The selected nodes will change their color. 

Defining the support 
property of the bottom 
column nodes 
 
 
 
 
 
 
 
 
 
 

 
 
56. Having selected the two nodes RC and select the 

SUPPORT command. The two bottom nodes of the 
columns will be turned into support nodes. 
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57. Select the command EDIT>UNSELECT NODES, to get 
off the Select Nodes environment. 

 

58. You have just completed the definition of the first 
frame. The second frame will be defined by creating a 
copy of the first in a distance in the x-x direction. The 
copy apart from the members and their geometry will 
also have all information relevant to the loads. 

USER ACTIONS 
 

59. Select the EDIT>SELECT MEMBERS WINDOW 
command  

 
60. LC somewhere on the left of above the structure. 

Release the button and move the cursor to the right 
and bottom, so that the window includes the entire 
structure. LC again. All structure members have been 
selected. 

 
61. Select EDIT>COPY 

 
62. Select EDIT>PASTE. In the appearing dialog box, type 

<3> to the <dx> field. The Program has copied the 
first frame with the loads on a distance of 3 m and 
created the second with its members parallel to the 
members of the first ones. 

 

Define the second frame 
 
 
 
 
 
 
 
 
 

PROGRAM FLOW 
 
 

 
 

63. Select the command EDIT> UNSELECT MEMBERS to 
get off the Select Members environment 

 
Change The Structure View 
Point 64. LC on the  icon. LC anywhere near the top node of 

the structure (the beams meeting point). Release the 
button and drag slowly the cursor to the right and 
bottom. Stop when you feel think that the viewpoint is 
satisfactory. 

 
 
 

 
 
 
 

 
PROGRAM FLOW 

 
USER ACTIONS 
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65. At the {Members Properties} Toolbar, make the 
following changes, 

a. Select the IPE 180(Fe360) section from the 
<Project Library> list. 

 
b. Select the <Fixed-Fixed> option from the 

<Constrains> list. 
 

c. Type <18,43> at the EULER field. 
 

d. Select <secondary beams> in the <Members 
Groups> list. 

 

e. Loads (LC on the  icon): <Dead>: <Global Z> 
with <Q> = {0,250} kN/m. <Wind + Y>: <Local 
Z> with <Q> = {0,70} kN/m. Check the <Snow 
1>: <Global Z> with <Q> = {0,05} kN/m. 
Uncheck all other options. 

 
 

Define Secondary Beams 

66. LC on the  icon. Make consecutive LC on the 
following nodes, {2,11}, {5,14}, {6,15}, {7,16} 

 
67. Because the secondary braces in the middle bear a 

load that is greater than the ones in the sides we will 
correct the loads. 

 
68. Select the command EDIT>SELECT MEMBERS. While 

keeping the [Ctrl] key pressed, select members 18, 
19, 20. 

 
 
 

USER ACTIONS 
 

69. LC on {MEMBERS LOADS} on the {SECTION 
PROPERTIES} frame (on the right). On the field <Load 
Cases> select <Dead>. Type {0.5} kN/m in the <Q> 
field. Select <Wind + Y> and type {1.2} kN/m. Select 
<Snow 1> and type {0.1} kN/m. 

 
 

Member Load Correction 
 
 
 
 
 
 
 
 
 
 
 
 

PROGRAM FLOW 
 

70. Select the command EDIT>UNSELECT MEMBERS 
 

71. At the {Members Properties} toolbar type <-18,43> at 
the EULER field 

 

Define the rest of the 
secondary beams 
 
 
 
 
 

72. LC the  icon, to see the {ELEMENTS LOADS} dialog 
frame again. Uncheck all checked loads. Press 
[Update] and [OK]. 
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73. Select again the  icon. Make consecutive LC on the 
following nodes, {8,17}, {9,18} 

 
74. We will define the members loads with the change 

method. 
 

a. Select the command EDIT>SELECT MEMBERS 
and select members 21, 22. 

 
b. In the frame {SECTION PROPERTIES} make 

the {Members Loads} tab visible 
 
 
 
 

USER ACTIONS 
 

c. Select <Dead> and type {0.5} kN/m at <Q> 
on the <Global Z> Axis. 

d. Select <Wind – Y> and type {-0.9} Kn/m at 
<Q> on the <Local Z> axis. 

e. Select <Snow 2> and type {0.120} for <Q> 
on the<Global Z> axis. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
PROGRAM FLOW 

 

75. Select the command EDIT> UNSELECT MEMBERS 
 

76. Select the  icon again. Make consecutive LC on the 
following nodes, {4,13}  

 
77. We will define the members loads with the change 

method. 
 
a. Select the command EDIT>SELECT MEMBERS and 

select members 23. 
 
b. In the frame {SECTION PROPERTIES} make the 

{Members Loads} tab visible. 
 

c. Select <Dead> and type {0.25} kN/m at <Q> on the 
<Global Z> Axis. 

 
d. Select <Wind – Y> and type {-0.45} kN/m at <Q> on 

the <Local Z> axis. 
 

e. Select <Snow 2> and type {0.06} for <Q> on 
the<Global Z> axis. 

 
 
 
 

USER ACTIONS 
 

Secondary Beams Load 
Correction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PROGRAM FLOW 

78. Select the command EDIT>UNSELECT MEMBERS 
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Define loads through filters 79. While the structure definition has been almost 
completed we have not defined any live loads on the 
secondary beams. We will define them with the 
Member Selection through filters method. 

 
80. Select the command EDIT>SELECT USING FILTERS. 

The dialog box of Image 7 will appear. 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
USER ACTIONS 
81. In the field <According to the Group> select 

<Secondary Beam (Steel)> and press [OK]. The 
program will automatically select all the members that 
have been defined as secondary beams. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PROGRAM FLOW 
82. On the {Members Loads} tab select <Live> and type 

{1.0} kN/m at <Q>. 
 

 83. Change this value for the secondary beams to {0.5} 
kN/m in the way that was described in steps 69/70. 

 
Define Roof Braces 84. At the {Members Properties} toolbar make the 

following changes, 
a. Select the <KT 40x40x2,6 (Fe360)> section from 

the <Project Library> list 
 
b. Select the <Pinned-Pinned> option from the 

<Constrains> list. 

Image 7 “SELECT USING FILTERS ” dialog box 

 
c. Type <18,43> at the EULER field. 

 
d. Select <bracing> in the <Members Groups> list. 
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 85. Followin the procedure at 52 define the members 
between the nodes {5,15} and {6,14} 

 
86. At the {Members Properties} toolbar type <-18,43> at 

the EULER field and repeat the procedure in step 52 
for nodes {8,18} and {9,17} 

87. You have just completed the model definition process.. 
Select FILE>SAVE to save your work. 
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STEP 6 DIAGNOSTIC CHECKS STRUCTURAL ANALYSIS 
 
Having completed the structure definition you should check its integrity and move on to the 
Space Frame structural analysis. The VK STEEL program provides a set of diagnostic checks 
to warn you about mistakes with a relevant message. 
 
On STEP 6 we will describe those two actions: Diagnostic checks and Space Frame 
structural analysis 
 
Follow the procedure 
 

WORK FLOW USER ACTIONS 
 

88. Select the command 
ANALYSIS>TOPOLOGY 
CHECK. The frame of Image 
8 will appear 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

89.On the dialog box check all 
options and press[OK] 

 

Topology Check 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

90.The should not be any errors. 
If there is one then follow 
again all steps in STEP 5 

 
 

WORK FLOW USER ACTIONS 
 

Image 8 “Integrity Tests ” dialog box
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91. If nothing went wrong in the 
Topology Tests then you can 
proceed to the Space Frame 
structural analysis. Select the 
ANALYSIS>STRUCTURAL 
ANALYSIS command. After a 
few seconds a dialog frame 
will appear like the one in 
Image 9.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Structural Analysis 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

92. Make sure that the Analysis 
drive (disk) is the same with 
the one you have installed 
your program and the value 
of <Accidental eccentricity> 
is {zero}. Press [OK] 

 
Analysis Report 93. When the structural analysis 

has been completed the 
analysis report will appear on 
the screen. It should look like 
the one in Image 10 

 
 

Image 9 “Analisys ” dialog box 
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Image 10 The “Result Test” Screen
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STEP 7 MEMBERS CHECK 
 
After the structural analysis the relevant node displacements, and therefore the member 
deformations, have been calculated. In other words we have found all stress magnitude 
everywhere where the program will run the checks. 
During the checks procedure the procedure the program factorises the stress values and 
according to their position (e.g. beams, columns etc) will run all Eurocode 3 required 
efficiency tests. In case of failure the check stops and the relevant failure message will 
appear in a dialogue frame, citing the member and failure type. 
For this example we will change a part of a beam so that it fails. 
Follow the procedure 
 

WORK FLOW USER ACTIONS 
 

94. Select the command EDIT>SELECT MEMBER 

 
95. SELECT beam 3 
 
96. In the “Geometry” tab of the {Section Properties} 

frame from the Section Type list select 
<IPE80(Fe360)> and click on the field right 
bellow. The section of the beam 3 has changed 
from <IPE(Fe360)> to <IPE80(Fe360)> 

 

Section change for a beam 
(for this example only) 

97. Repeat the procedure we have described in STEP 6 
 

Members Check 
 
 
 

98. Select the command ANALYSIS>MEMBERS 
CHECK. The dialogue frame in Image 11 will 
appear 
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 Image 11 The “Members Design” Dialog box  

 
 
 

99. Make the following selections,  
 
 

a. On the Designation unity select 
<Frames> and <Non Sway> 

  
b. On the Display Messages  unity select 

<Show messages on design excess> and 
<New failure log File> 

 
 
 
  

c. Make sure the <Check all members> 
check box is checked 

 
 
 
 

 
100. Press [CONTINUE] 
  
101. After a while the program will stop and the 

message of image 12 will appear 
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 Image 12 The “Stop in Excess” window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
102. The message says which member fails, where it 

failed the load combination during which the 
message appeared and the reason 

 
 
103. Press [CONTINUE] 
 

104. This time the message of Image 13 will appear. 
Notice that while we are still on the same 
member the failure is due to another reason. 

 
 
 

  
105. This time select <Overcome all warning stops for 

all remaining members> 
 
 

  
106. Press [CONTINUE] again. The program should 

not stop until the end 
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Image 13 The {Stop In Excess} window frame. This time the 
excess is due to member buckling on the Z-axis, because of 
Load Combination 2

 
 
 
 
  
 107. After having selected the [CONTINUE] button, 

the program will keep on checking all members. 
Because you have selected <No more 
interruptions from all diagnosis in all members> 
the Members Check will not stop even if it meets 
some excess. This of course, does not mean that 
the checks do not take place. All excess messages 
are collected and written in a printable format 
file, the appearance of which notifies for the 
check procedure end. The excess message file will 
look like the one in Image 14 

 
 
 
 
 
 
 
 
 
 
  
  
  
 108. Press [CONTINUE]. A new window will appear, 

the section modification results window. The 
window displays the contents of the automatic 
section change file – it should be blank for you, 
since you did not use that method. Press 
[CONTINUE] again to complete the procedure. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Correction 109. To restore the beam you have to reset the 

original beam, as we have previously described 
and to proceed again to structural analysis and 
members check. 
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Image 14 The Error Messages file (excess messages) on display window. You can print 
the file by selecting the [PRINT] button. 
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